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1. Software introduction 

Cube-3d is a mapping and aerial image processing software solution. It lets you build professional 3D models from 2D 

images and geospatial data, captured using drones or other vessels and devices. Cube-3d offers photogrammetric 

processing (building geometry, geo-referencing, dense reconstruction) as well as 3D modelling and analysis of both Cube-

3d-generated photogrammetric point clouds and third-party source data (las, LiDAR, CAD, etc). Create your own 

orthophotos (DOF), digital surface models (DSM) or calculate volumes and manage stockpiles in a fast and easy manner. 

An integrated reports wizard will help you put all that work together in a compact and presentable way. 

Type of accessible data differs from project to project as should workflow. Two most popular use cases: 

1. Drone flight & Mission Planner + Cube-3d Processing + Cube-3d Modelling and Analysis 

Capture your own images (along with EXIF, GNSS, GPS RTK, etc. data for geo-referencing) and import them to Cube-3d for 

photogrammetric processing.  Set parameters for bundle adjustment, orientation (geo-referencing) and reconstruction.  

The result will be a metric, geo-referenced, realistically coloured 3D point cloud that serves as a basis for all further 

calculation, modelling and analysis. Learn more about project preparation or jump to License details. 

2. Cube-3d Modelling and Analysis 

Just finished with Processing? Importing third-party data, such as las point clouds, photogrammetric point clouds from 

other sources, LiDAR, etc. without having your own data for photogrammetric processing? No problem. This part lets you 

build, manipulate and customize point clouds, DSMs, DEMs, orthophotos, calculate volumes and profiles, contour lines, 

generate reports and export data in various formats for further CAD or any other use. Go to Modelling & Analysis. 

This manual will help you get the most out of Cube-3d to achieve high-accuracy, survey-grade results in a professional and 

high-tech approach. Naturally, being a team of surveying professionals, we made sure that Cube-3d also supports data 

acquired with classical measuring methods and devices. 

 

1.1. System requirements 

Cube-3d runs on Windows 64-bit operating system. Processing runs on CPU, graphical interface runs on GPU. For best 

performance and speed make sure you have enough RAM (16GB+). See below for further specification requirements. 

 

Minimum system requirements: 

Windows 7, 8, 10; 64 bit 

I5/i7  

16 GB RAM 

Nvidia GTX760 

SSD 128 GB + HDD 500 GB 

 

Recommended system requirements: 

Windows 10; 64 bit 

i7: https://ark.intel.com/products/88967/Intel-Core-i7-6700HQ-Processor-6M-Cache-up-to-3_50-GHz 

16 - 32 GB RAM 

https://ark.intel.com/products/88967/Intel-Core-i7-6700HQ-Processor-6M-Cache-up-to-3_50-GHz
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Nvidia GTX960 or better 

SSD 256 GB + HDD 1 TB 

 

Advanced Professional Use (large datasets, full-frame cameras): 

Windows 10; 64 bit 

i9: https://ark.intel.com/products/123613/Intel-Core-i9-7900X-X-series-Processor-13_75M-Cache-up-to-4_30-GHz  

64 - 128 GB RAM 

Nvidia GTX960 or better 

SSD 512 GB + HDD 1 TB 

 

1.2. Graphic card usage 

Using notebook PC: Power plan should be set to high performance 

In case of additional graphics card: Dedicate the use of graphics card to Cube-3d.  

Right click on Cube-3d shortcut -> Run with graphics processors -> Change default graphics processor…  

When card’s control panel pops up, go to Manage 3D settings -> Program settings. Check if Cube-3d is on the list of 

selected Program to customise. If not, click Add button and find Cube-3d. Click Add Selected Program and close Control 

panel.  

 

1.3. Cube-3d modules 

Several modules of Cube-3d are available, subdivided as follows: 

https://ark.intel.com/products/123613/Intel-Core-i9-7900X-X-series-Processor-13_75M-Cache-up-to-4_30-GHz
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Tool PHOTO SCANNER PRO 

3D Model from images/video ✔  ✔ 

GCP Orientation ✔  ✔ 

Classification ✔ ✔ ✔ 

Point Cloud Registration  ✔ ✔ 

Mesh Calculation ✔ ✔ ✔ 

Ortophoto ✔ ✔ ✔ 

2Dviews Generation  ✔ ✔ 

CAD ✔ ✔ ✔ 

Volume Calculation ✔ ✔ ✔ 

Profiles Calculation ✔ ✔ ✔ 

Contour lines ✔ ✔ ✔ 

Video Recording ✔ ✔ ✔ 

 

The PHOTO module allows you to completely process photogrammetry data, from the images to a complete 3D model 

with analysis, The SCANNER module is designed to import, register and analyse point clouds from laser scanners. The 

functions presented within this manual are all available within the PRO version. Next to each section, you will find a legend 

representing the modules for which the described function is available.  

Legend: 

PH = PHOTO module 

S = SCANNER module  
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2. GUI (Graphical User Interface) walkthrough 

2.1. Welcome screen  

Opening Cube-3d brings us to a welcome screen with a couple of options to start our project; New project, Open an 

existing project, or select from recent projects list. Other buttons remain disabled as no data is loaded in the app. 

 

 

Graphical user interface of Cube-3d consists of four fundamental sections with tools, advanced options, guidelines and 

information for data processing: 

1. Toolbar is the upper left part that provides us with all main options 

2. Working Panel is located on the right side containing seven tabs, each giving us basic and advanced tab related 

tools. Tabs unlock as we move through processing to point cloud, modelling, Orthophoto, etc. Some menus, as 

well as some functions are locked due to either lack of data or because we tried to skip some of the processes. 

3. Live Command Window is located on the lower left part, providing us with live results of running functions: 

coordinates of marker’s position, computed distances, etc. 

4. Viewer is the central board for viewing images, and all of 2D or 3D data. 

 

2.2. Viewer and live command window 

Main Viewer screen and Live Command line provide and interactive graphical and numerical interfaces for you to control 

and work with models, results, pick points, monitor coordinates as you explore your 2D or 3D material. The easiest way to 

handle models in Cube-3d is using a mouse and its four operations. Left mouse click is, just like any other app, used for 

selecting (starting polygon selection). When selecting polygon, use left mouse button to determine its points and right 

mouse click to finish your selection. To rotate models, click and hold left mouse button. To zoom in or out use the scroll 

wheel. If you need to shift the selected angle of view at selected zoom, click scroller and use it like pan function. When 

viewing Orthophotos or Profiles use scroller to zoom and pan. 

4 

1 

3 

2 
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3. Preparation of photogrammetric data (PH) 

Prepare your project folder on your disk and copy your images of selected project from SD card into the folder. If your UAV 

supports telemetry, use that data. Depending on your UAV model, telemetry data are ascribed to images, or recorded into 

*.csv file.  

The .csv file must also be added alongside images and consists of further data: enabled, index, longitude, latitude, altitude, 

date, time, yaw, pitch, roll, x Sigma, y Sigma, z Sigma, p Sigma, blur, and file name. Organization of data must be known 

but is to be specified as you wish. See below an example of generic telemetry file (use this option if your UAV type is not 

listed). It is recommended you save your ground control point coordinates (GCPs) .txt file into the same folder as your 

image files. GCP file should be organized in the following way: point name, x coordinate, y coordinate, z coordinate – space 

delimited. Be advised, it is highly recommended to make some map of GCP/validation points locations especially when 

large datasets are in use. 

Example of GCP coordinate file: 

 

Example of csv telemetry file: 
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Example of .csv generic telemetry log file: 

 

 

3.1. Option settings (PH, S) 

Start Cube-3d and set language. Click Options -> Application settings and select language and units- You have to restart 

application to assign applied changes. If select Automatic machine deactivation, after closing the software the machine 

will be automatically deactivated, letting the user to use the software a second computer without removing the license 

manually. 

You can also set the number of decimal places shown in CAD measurements, up to a maximum of 5. 

 

When imperial units are selected, you can further assign weather you want International foot or US survey foot. You can 

select Other. On the right, where by default is set 1.000000000000, type value of 1unit in meters.  

Next, click Bundle Adjustment.  
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There you can assign: 

Number of Maximum parallel threads depend on your computer CPU type. For default value Cube-3d checks number of 

available threads and directs them all. Decreasing threads is an option when RAM is insufficient to avoid plausible comp 

crash. It is imperative to keep sufficient level of RAM and processor. For example: if you have a good i7 processor with 4 

cores – 8 threads and just 8GB of RAM we would advise you to lower the threads number to 4. This will avoid memory leaks 

during the processing. 

Number of Maximum detected features, default number is 40.000;  

Features correspond to so called tie points on each image further used for “sawing” them to strings and strings to block. 

Feature detection level defines robustness of the matching step. Level of detection is inversely proportional to reliability 

and smoothness of detected points – features. Level of detection is also proportional to time of computation. Levels rise 

from Normal, High to Ultra. 

Click Reconstruction to set Number of maximum parallel threads, where default value is 8. When all preferred values 

are assigned, click Ok to assign selected measures.  

 

 

To save the changes for Language and Units you have to restart application to assign applied changes.  
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Changes of Bundle adjustment and Reconstruction settings are confirmed with selecting OK button - You don’t need to 

restart application. 

Note, that, if selected language is other than English, furtherly named command buttons and functionalities will be 

translated to selected language and will therefore defer from presented screenshots. 

 

3.2. License details (PH, S) 

All cube-3d licenses are floating licenses. Just go under Help -> License and click on Deactivate machine. 

This will allow you to use the same license on another machine. Is possible to check also the active 

modules. 

In case you have a new code, click on Change license key. 
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4. Processing (PH) 

Aerotriangulation, Geo-referencing and Reconstruction 

This part of Cube-3d empowers you to import your own dataset(s) containing images and geospatial data to generate 

metric, geo-referenced point clouds that serve as a basis for further modelling and analysis. When using unmanned or 

manned aircraft for the resulting data are overlapping aerial images along with image positions (exif gps, rTK, PPK, etc.) 

and/or GCPs to further improve geospatial orientation of the model. Therefore, it is advised to utilise flight mission planning 

software/app compatible with your UAV (pixhawk, GS Pro DJI, etc.). Flight path needs to be planned as to achieve image 

overlap that is paramount to successful matching and alignment of the images. Recommended overlap is 70% or more 

(For terrain with higher terrain difference increase it up to 80%).  

Another important parameter of mission planning is setting the right flying height. Its value depends on desired ground 

pixel size, resolution of used camera, and terrain characteristics. If your platform supports telemetry data, this is where it 

comes into play. Use it. To further improve geo-locating and referencing your project/model it is recommended to use 

ground control points. They need to be distributed across the surveyed site properly as to provide adequate spatial 

reference (minimum 3 GCPs, recommended 9 GCPs per every 500m x 500m area/segment). GCPs can be measured manually 

using GNSS devices (or any other device with GPS/GNSS capabilities) and can be in the form of natural/manmade features 

(building corners, rocks, manholes, shafts, etc.) or in the form of ground control targets. You can find the video description 

for all the procedure in the following video:  

To recap: Place GCPs → Plan flight mission + UAV flight (capture images and positions) → Import to Cube-3d. 

 

4.1. Setting flying height 

To achieve great results, make sure you start with the correct settings right at the beginning. Higher overlap means more 

images and more images means longer processing time. The minimum overlap between images is 65% (front and side 

overlap). However in some cases (wide-angle cameras, high vegetation, uneven terrain, etc) it is safer to increase these 

values to 80%. Below are instructions on how to best prepare and set up your flight mission to get the best possible 

orthophoto with minimum processing time. In case you would like to calculate volumes, as well, additional side images will 

have to be captured – see the instructions for Volume calculations.  

Standard settings for any drone, any camera:  

• Camera angle nadir direction (vertically downward) - 90° angle  

• Flying height from 40 - 150 m AGL (above ground level) - Usually 80 m  

• Front Overlap (overlap in the flying way) 80%, Side overlap 75%.  

Most drones automatically geotag the images based on drone GPS (usual accuracy 1,5 m) and you can orientate the model 

in Cube-3d based on that telemetry data. If you would like to achieve survey-grade accuracy (up to 4 cm), don’t forget to 

set up GCPs before the flight and measure them with survey-grade RTK GNSS. In case you have a drone with RTK GPS with 

1 cm accuracy you can use that data to orientate the model accurately without employing any GCPs.  

Note: We always recommend using GCPs if the type of terrain allows for the placement. Cube-3d supports all combinations 

of geo-referencing data, including or excluding GPS inputs in the processing stage is also supported. Check the instructions 

hot set them correctly: GCP Setup  

Tips and Tricks:  

1. Start your mission from the highest point in relation to the terrain you are about to map. Most drones (DJI 

Phantom 4, Yuneec, DJI drones) fly missions in a single plane and don’t automatically adjust their flying height to 

https://d52dhomxeqj2r.cloudfront.net/Support/Products/Software/Cube-3d/Tutorial/Cube-3d_PerfectOrthophoto_ENG.pdf
https://d52dhomxeqj2r.cloudfront.net/Support/Products/Software/Cube-3d/Tutorial/Cube-3d_GCPSetup_ENG.pdf
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the terrain characteristics. This can result in an insufficient image overlap (less then 60%) when capturing higher 

terrain points, high buildings, high trees, etc. in case you start the mission from lower positions.  

a. Best practice: Drone mission 80m 80% overlap 65m 70% overlap 95m 90% overlap  

 

b. Wrong starting point:  

 

2. Lower flying height with better ground pixel resolution (GSD) does not always mean better results. In areas with 

high density of buildings, flying too low can result in the following:  

a. High buildings will not be ortho-projected in the digital orthophoto. 

 

b. Image stitching can be less than perfect if they are directly over a building.  



 

Stonex Cube-3d – User Manual   16 

 

To eliminate the over-the-building image stitching we advise you to have the whole building on a single image. First, 

perform your mission at 80 m AGL, then manually trigger a few nadir images from a higher AGL (120 m above the object, 

for example) to get the whole object in one image. That enables you to recalculate the area with - or/and around - the 

building. 

 

4.2. GCP setting up 

Ground control points orientate the model and improve the accuracy of calculated model. Minimum 

required number of GCPs to orientate the model is 3, however it is highly recommended you always use 

more than required. We advise you to set up a minimum of 10 GCPs per 10 acres (most common area size 

that can be mapped with a Drone on a single battery).  

Use recognised targets (1. Stonex AutoDetect Target, 2. Checkbox Target, 3. AprilTags, 4. Custom) as GCPs, 

place them on the ground before flight and measure them with a GPS (GNSS) or total station. 

 

Use the advanced automatic orientation in Cube-3d.  
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Note: in case you are not using Cube-3d ground control target template you can measure any characteristic 

point in the area of interest, such as manholes, curbs, road markings, etc. That still enables you to do the 

orientation in Cube-3d but in this case semi-automatic.  

Accuracy of the end model depends on:  

• Camera type  

• Flying height (image resolution)  

• Number of GCPs and correct setup  

Best practice GCP setup  

Square areas GCPs should be spread across the whole area as uniformly as possible and should not be 

placed to close to the border of the area of interest.  

 

In case of uneven (or rugged) terrain it is highly recommended to place GCPs on both lowest and highest 

points of your area of interest. 
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 To achieve survey-grade accuracy, place your GCPs 50-100 m apart. Higher density of GCPs also means 

higher accuracy of end results. 

 

 

Road/Railway example of GCP setup  

To achieve survey-grade accuracy (up to 4 cm) we advise to set up GCPS in pairs every 50 – 100 m – one to 

the left and one to the right of the object of interest (road, railway, river bank, etc). This will provide you 

with a stable and consistent accuracy across the whole area – around the pairs as well as between them.  

 



 

Stonex Cube-3d – User Manual   19 

4.3. Uploading images with saved metadata (PH) 

Start Cube-3d, select the button New project in the Viewer and select the project images in the folder. The same can be 

done via the Toolbar Images - > Load images. 

 

 

When images are uploaded, the telemetry importer window appears. For DJI drones, Yuneec drones and all other drones 

that write the GPS position of the images during flight use EXIF data.  

For drones with a separate log file, use one of the following options: 

• C-astral Bramor → *.csv 

• MaVinci Sirius Pro → *.csv dati Exif (DJI Phantom 4, Inspire 1, eBee, Falcon 8,..) 

• Other → *.csv 

When images are imported, their telemetry is read. This opens a page where you enter the coordinate system of the images 

and the project. If the images already have this information the software reads it automatically, otherwise you can set it 

manually. You can select the horizontal coordinate system, and also the vertical coordinate system. Then select whether 

the height is ellipsoid or geodetic. 

It is also possible to select previously created presets, changing from Custom to another system. 
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The telemetry will be read in automatically and a new window will open. The Telemetry window will open, presenting the 

imported data and their transformation into the project's coordinate system with their accuracy. You can manually set the 

accuracy and determine the Camera to GCP offset and Flight Height. If you imported the wrong log file, click on 

Reimport, to re-import the telemetry data or/and close. Camera positions are displayed in the Viewer after the data has 

been imported and processed.  
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4.3.1. Uploading images with external telemetry (PH) 

If the images you upload do not have telemetry values saved in the metadata, you can upload an external file with this 

information. Select the pen icon. 

  

First set the data delimiter. Click where Semi-column [;] is displayed and select the delimiter sign. Now you have to assign 

the attributes of your log file to each column. Click on a tab at the top of each column, where none is displayed. Scroll 

down the list and click on the desired attribute to assign each column to the specified attribute. 
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See below for an example of what the file should look like to import telemetry data. 

 

It is then possible to select the coordinate systems of the images and the project. To search for the desired reference system 

or geoid, click on the datum name and type in the name or keywords for the search. Once all the data have been selected, 

click on Import. 

The telemetry will be read in automatically and a new window will open. The Telemetry window will open, presenting the 

imported data and their transformation into the project's coordinate system with their accuracy. You can manually set the 

accuracy and determine the Camera to GCP offset and Flight Height. If you imported the wrong log file, click on 

Reimport, to re-import the telemetry data or/and close. Camera positions are displayed in the Viewer after the data has 

been imported and processed.  
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4.3.2. Commands for images (PH) 

At the top left of the Viewer, you will see four buttons, Images, Maps, Telemetry and Sparse point cloud to view the 

data in your preferred mode. At this stage, Sparse point cloud is not available. When in telemetry mode, three buttons 

appear in the top right-hand corner. 

The third button is for displaying image names. By default, all imported images are selected the number of images selected 

from those available is shown in the work panel. Use the Deselect button to exclude any number of images from the group 

setting. Use the left mouse button to draw the polygon surrounding the desired cameras. Close the polygon and confirm 

your selection with the right mouse button. The deselected images will change colour from blue to grey and in the list of 

images in the working panel, the deselected images will be unselected. If you want to include some of the deselected ones, 

click on the Select button to reselect them, or dock them in the image list. This has intrinsic value in two cases: 

• When a dataset of more than 1000 images is processed, probably the most efficient way would be to process 

them by parts; 

• You can easily de-select images that are not important for your project and would only increase the processing 

time of your project - panoramic images, images while lifting the drone to the exact height, etc. 

4.3.3. Advanced Explanation on Coordinate Systems (PH, S) 

When importing image telemetry data or ground control points, the data and project coordinate system must be selected. 

When assigning the preferred project coordinate system, as described in 4.3.1, you may be interested in the data displayed 

along the selected coordinate systems. 

 

In the window you can select presets created by the software for different regions, load presets in PRJ/WKT formats or set 

up a custom system.  

 

If you are working in custom mode, you can select either a horizontal or vertical system for your system. Click on the name 

and type in the system name or keywords to search for it. 

Once selected, click select. The custom datasets created can be saved in different formats (WKT, PRJ, JSON) by clicking on 

the icon at the bottom right of the main software screen. 

 



 

Stonex Cube-3d – User Manual   24 

 

4.4. Bundle adjustment (PH) 

If you have camera calibration parameters, click  and load camera parameters. Such data significantly improves the 

speed of the process of bundle adjustment and should be imported if available. For most popular drones (DJI Phantom 4, 

4 PRO, Mavic, ...) the predefined parameters are already integrated in the software and you don’t need to import it 

additionally. In case you are using other cameras, we advise you to calibrate your camera on your fist project and use those 

parameters for future projects. Check out chapter: 4.3.4.3 Export camera calibration for detailed instructions. 

Above Bundle Adjustment button number of all images is presented as a number of used images. Press Bundle 

Adjustment to calculate parameters of camera orientations. 

 

 

You need to select the Mode of adjustment: 

- Global is faster method suitable for larger datasets – use it for default setting. In case you will not be satisfied 

with the number of matched images repeat the Bundle Adjustment calculation with Incremental approach. 

- Incremental is slower but more stable – suitable for project where image texture or overlap isn’t the best: High 

vegetation, bad overlap between images, blurry images… We advise you to use incremental approach for data 

sets up to 500 images (because of the processing time…) 

- Hybrid is combination of global and incremental mode. It gives the best result using characteristics of both 

modes, but is also the slowest. 

Click Show more, to select:  

- Maximum CPU workers: The number of CPUs working together. 

- Maximum detected features: The maximum number of features that will be extracted from the images. 

- Feature detection level: The level of feature detection: Normal, High or Extreme. 

- Pair selection: How to select and pair images: 

o Telemetry: look at the drone's telemetry. 

o Generic: try to choose images at random and try to pair them. 
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o Sequential: use in case of images extracted from video. Select images sequentially. 

o All: Try to use all the previous methods. 

- Use telemetry data: if you have drone telemetry you can orient the cloud with it. 

Click OK to start Bundle adjustment. The processing time could be between a couple of minutes and up to several hours. 

It depends on the number of images and your CPU specifications (number of cores…) 

Note: Try to save your project after every operation (Bundle Adjustment, Orientation and Reconstruction). It can be done 

through Toolbar Project > Save project. The latest version also has autosave, which makes that for you. 

All images must be imported from a single folder to be processed as one project. Some of the drones start to write images 

in a second folder after 1000 created images and start once again with the image name 001.jpg (Phantom 4 Pro). In this 

case rename the images in second folder and copy all in one folder. 

Once project is bundle adjusted, you can observe several functions in the viewer. As before, you can watch images, or click 

telemetry, to observe location and orientation (external orientation) of images. Toggle text, to view or not image names. 

 

Click sparse point cloud to observe sparse point cloud beneath telemetry data. There, you can toggle text, select or 

deselect desired camera positions or click convert to point cloud that shifts your position in the working panel from 

Images to point cloud. 

 

4.4.1. Bundle Adjustment troubleshooting 

If bundle adjusted set of images is beneath your expectations, here are some guidance, that might help. 

In case, that matches were found on only half of the selected images (probably due to insufficient overlap, bad texture on 

images, high vegetation, images of water areas that are blurry) you may get better results by: 

- recomputed Bundle Adjustment using Incremental mode. If results aren’t better, proceed; 

- go to 3Dproject folder, and inside the folder with images manually delete folder named “Features”. Then increase 

Number of maximum detected features to 80.000 in Cube-3d -> Options. Results should be better. 

If the results are still insufficient: repeat the step 2. and increase also Feature detection level from Normal too High or Ultra. 
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After computation, set all changed parameters back to default, because made changes increase processing time and are 

unnecessary for standard datasets. 

Default values of Number of maximum detection features is 40.000. Feature detection level is, by default set to Normal. 

4.5. Orientation (geo-referencing) (PH) 

To geo-reference a project, proceed with Orientation. Three options are available depending on your data type. 

4.5.1. Orientate with telemetry data 

In case of available and imported telemetry data, you can orientate images using just telemetry recordings, although it is 

recommended to use GCPs to achieve better accuracy. Remember, in the process of Bundle adjustment you selected 

weather you wish to orientate images or not. 

 

To proceed, click Orientate with telemetry data and follow the pop-up wizard. First you inspect location of images in 

assigned coordinate system. Some rows might be seen in grey colour as image’s telemetry has error. To proceed, click 

Next. 

file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_Bundle_adjustment
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Orientation summary window presents residuals of adjusted camera positions on all three axis and its spatial value. Click 

Finish to complete orientation. If some images have errors in telemetry, they appear as unregistered in the List of images 

in Working panel. 

 

4.5.2. Orientate with GCP 

In most cases, especially when telemetry data cannot be measured, or it isn’t accurate enough (most UAVs caries GPS 

antenna with 1.5m accuracy), block of images is orientated using ground control points (GCPs). Position of GCPs are 

measured using GNSS services or by total stations.  

 

To proceed, click Orientate with GCP and follow the Orientation pop-up wizard. First, select ground control points (*.txt) 

file and click import. Define the file delimiter. You can change the type of data to be read in each field, and you can ignore 

some fields by putting NONE on the column. Finally, choose the reference system. 
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In the next screen you can define the type of target used, its size and the method of use of the control point. Click on the 

field after the points name and select whether it is a ground control point (GCP) or a validation point: 

• GCP - its reference coordinates are used in the orientation adjustment, 

• Validation point – excluded from orientation adjustment and used for quality assessment at the end of the process. 

In case you select the wrong coordinate system by importing the images into project, be reminded that you cannot change 

project coordinate system in this step. If you would like to correct this you need to start from the beginning (New project, 

…) or use the second option – select: Local coordinate system. Further information about coordinate systems can be found 

in chapter Bundle Adjustment troubleshooting. 
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If you continue, you will end up in the screen for selecting control points within the images. 

 

4.5.3. Automatic orientation 

On the left of the pop-up window, select image with GCP. Use mouse scroller to zoom in or out. For automatic orientation 

a minimum of 3 GCPs need to be manually marked. Mark GCP with a right mouse click. Marked position is coloured in 

orange and ascribed a ‘’?’’ as its name is not defined.  

GCP Map 

Expected errors 
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Continue by selecting additional two GCPs from other segments of your project area. When you select the third ground 

control point the automatic recognition for all other GCPs will start. Three marked GCPs remain orange coloured while 

automatically found GCPs are now coloured green and the names of all GCPs are identified. 

 

If you mismark the position of the ground control point, click Clear all marks button and reselect. Otherwise, click Confirm 

unknown marks. A useful tool for checking the appropriation of GCPs are their residuals. If displacements of selected points 

are high, you should check if you forgot to survey one of them (their position is missing in the file). Described method of 

Automatic orientation as furtherly described Troubleshooting with orientation in chapter Troubleshooting with orientation. 

 

4.5.4. Semiautomatic orientation 

Use GCP Map and select first the name of the ground control point on GCP map with left mouse click (for example 2009) 

and mark its position on image with left mouse click. Marked position is coloured blue, and its id appears.  

If you mismark the position, click Clear mark button and reselect. Clear all marks button clears all selected markers. 

http://www.3dsurvey.si/support/tutorials/3d-model-orientation-with-exifgps-and-ground-control-points-gcp
http://www.3dsurvey.si/support/tutorials/gcp-orientation-troubleshooting
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Select two more GCPs with a left mouse click (same as above). When you select the third ground control point the 

automatic recognition for all other GCPs will start. GCP are now coloured green and the names of all GCPs identified. 

 

 

In the lower right corner appears the residuals of marked points. Residuals should be within 1m. Check if the automatic 

positions are calculated correctly - GCPs need to be coloured green. If not, correct them with manual selection. First, select 

the name of GCP on GCP map, then show the exact position of GCP map on an image. Use left mouse click. 
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In case you are using STONEX GCP targets (black dot on white plate) be sure to select the ‘’Detect targets’’ and set the 

correct diameter for the black dot. The default value for diameter is 0,27m (standard Cube-3d target). In case you are using 

some detail points for orientation as manholes, road marks, building corners… deselect ‘’Detect targets’’ click next to 

continue with orientation.  

 

In the next step, we can see automatic recognition of ground control points (in case of Cube-3d targets). If the GCP is not 

recognised on a specific image, it is eliminated and coloured red. If you want to include this GCP into orientation, just 

double click the image and the red overlay will disappear. Several images can be marked or unmarked by ticking them in 

their upper left corner, where unticked square appears. Use Ctrl + A shortcut to select all target windows at once. You can 

also correct/realign the automatic measurement - left mouse click and move the centre of GCP to the green cross. Same 

approach can be used to correct the positions of GCPs that have been automatically detected but not measured perfectly 

because of the bad conditions during data acquisition.  

 

Faster approach for centring target is provided by the right mouse click. Put the mouse in the centre of the target and right 

mouse click for centration. Use mouse wheel or slide bar below to zoom in or out, which works for all target windows to 

realign easier.  

If you are using the same dataset in numerous computations/projects it can be useful to export GCP image positions of 

centred targets. Click tooth wheel button in the upper right corner and click export. In case if you calculate the same 

project again next time you don’t need to select and correct the GCP targets once again but just import the saved file and 

go to next step. 
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Click Next, to observe orientation’s accuracy. 

Orientation summary displays GCP errors – a sum of photogrammetric measurements and total station /GPS measurements. 

Check GCPs accuracy by observing their residuals. If residuals show high displacements of certain GCPs, go and recheck 

them. Click back button on the upper left corner and repeat the marking process. Click Finish when satisfied. Remember 

to save the project. 

 

To check for independent accuracy quality, GCPs can be marked as Validation points that provide independent values to 

compare against GCP values. Points defined as Validation points get coloured grey. 
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In the orientation summary, you can observe adjusted accuracy presented with residuals. As four points are used as control 

points, orientation is computed based only on selected GCPs. As described above, residuals need to be low. Impact of their 

size can be observed on residuals of control points. In case of high values markings need to be corrected. 

 

4.5.5. Troubleshooting with orientation 

In case if automatically selected point markers mismatch - residuals show large coordinate differences, that exceed 1m 

limitation for presentable final centring, as presented below - you should click clear all marks and proceed semiautomatic 

orientation, as described above.  Keep in mind that selected points need to be observed – have observed coordinates 

written in *.txt. If at the beginning of the orientation, at least one of selected markers is declared as control point, residuals 

will show misplacements.  

If you would like to continue with the standard workflow, continue with the Reconstruction.  

 

4.5.6. Orientation of unknown dataset 

Sometimes you need to process dataset of one of your co-workers. You weren’t present during field work and you do not 

have any map of positions of GCPs. There are several ways to proceed: 

• Use Automatic orientation method 

• Select all GCPs as validation points and use Semiautomatic orientation method for GCPs you are shore of its 

position. Observe residuals from the list, and if for some GCP values are high, select it from the list or click on it in 

the map and click clear mark. It is time consuming process especially when processing large datasets. It is highly 

recommended to make and archive some map of GCP / validation point locations. 

 

 

 

file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_4.3.3.2.1_Automatic_Orientation
file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_4.3.3.2.1_Automatic_Orientation
file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_4.3.3.2.2_Semiautomatic_orientation
file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_4.3.3.2.2_Semiautomatic_orientation
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4.6. Advanced functionalities (PH) 

4.6.1. Export camera parameters and undistorted images 

If you would like to import results of Bundle Adjustment in any other photogrammetric software, you need to export camera 

parameters and undistorted images. Click Data, chose export camera parameters. Type preferred name of exported 

document or chose predetermined one and confirm. 

 

4.6.2. Export undistorted images 

Click Data and chose export undistorted images. In the popup window assign path of directory and type in its name. 
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4.7. Reconstruction (PH) 

When you are finished with orientation wizard the main window will appear. Next step is Reconstruction of dense point 

cloud.  On image you can find the default values for Reconstruction step which offers you the most effective calculation 

(time VS results).  

 

Click OK to start reconstruction. 

Continuing each reconstruction parameter is described for more information.  

Reconstruction level – there are 4 levels of reconstruction:  

• Low, 

• Medium, 

• High, 

• Extreme. 

Use graphic card – Falg only if graphic card is installed in your device. Only NVIDIA supported. 

As the reconstruction is in progress, the Point cloud tab unlocks in Working panel. In the Viewer, the progress bar displays 

the stage of completed processing. The predicted processing time is realistic after 7% of the process is computed. 

 

 

Reconstruction advances 

As described in Option settings desired images can be chosen to reconstruct point cloud from.  When all images are being 

orientated, point cloud can be reconstructed from only one selected image. Although you chose only one image, app runs 

reconstruction with all of overlapping images, with same detail of surface. Select preferred images and run reconstruction. 



 

Stonex Cube-3d – User Manual   37 

You can use select or deselect button or manually deselect images from the image list. Further assign desired level of 

reconstruction, number of overlapping images and possibility of optimization. 

This function allows you to process the dense reconstruction for one project in two pairs (1st half and 2nd half) or calculate 

the dense reconstruction with a different level – for example: centered area with Extreme level, less important area on High 

or Medium level.  

To see the effect, we selected point cloud (coloured purple) reconstructed from one selected image with its overlapping 

images selected amongst point cloud reconstructed from entire batch of images. Although selected image was from the 

first row of images, about 700.000 points were reconstructed. 
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5. Point clouds registration (S) 

5.1. Manual registration (S) 

Import the point clouds you wish to register. Click on Point Cloud, then click on Load. Both point clouds will be 

displayed in the viewing area. Once loaded, click Manual Registration in the tools area. 

 

In the registration window, the two point clouds will be displayed side by side in two windows. On the left the one to 

be recorded, on the right the reference one. You can import a GCP co-ordinate file by clicking on the folder icon of 

both point clouds. 

 

Under 'options' it is possible to switch between colour and other colour displays such as intensity or height scales, and 

it is also possible to increase the size of the dots. 
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You can create matches manually if no GCPs have been collected or if you wish to add more. In the registration window, 

double-click on a point cloud to enlarge it. Navigate to a recognisable point in both point clouds, then click to create 

a new match. Two matching points must have the same name to be connected correctly. 

You can also fix the Z-axis (fix z-axis) if the scans have the same levelling or fix the scale (fix scale). 

In the central part you can see a preview of the errors. By marking Generate report you can save a report file with the 

residues. You can delete a point by clicking on the 'x' next to it. When finished, click Save. 
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Here is an example of a registration report. The average errors and residuals for each match are shown as 3D error and 

error for each coordinate. 

 

5.2. Automatic registration (ICP) (S) 

Right-click on the name of the point cloud whose registration you wish to refine. The ICP algorithm is used at this stage. 

You can also click on the button at the bottom right of the tool section to activate automatic registration. 

 

 

Select the point cloud you wish to record and the reference cloud, then also select an ICP mode from Fast, Normal and 

Accurate. 
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A report can be generated, as for manual recording, by ticking the corresponding option. 

 

 

Here is an example of an ICP report 
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6. Point cloud manipulation (PH, S) 

The calculated point cloud will appear in Point Cloud tab. To manipulate the point cloud: use left mouse click to rate point 

cloud, scroll to zoom in or out, click and hold the mouse scroller to pan the model. 

 

 

Point Cloud includes points from surface, buildings, vegetation and other objects. To generate a digital Orthophoto those 

obstructions need to be eliminated (select and delete) as to get a clear digital terrain model that serves as a basis for 

Orthophoto generation.  
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6.1. Point rendering (PH, S) 

 

Use the Point render size bar to increase or decrease the points of Point Cloud. 

 

 

6.2. Point snapping (PH, S) 

Use the Point snapping tool to inspect the 3D coordinates of the point cloud. The x, y, z values are presented in the live 

command window (lower right corner). 
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6.3. Cube-3d viewer (PH, S) 

Use Reset view to set the default view. 

 

 

If you would like to view PC or DSM from nadir projection, click  Top down button. Model can now be rotated only around 

z-axis. The button is on as long as you do not switch it OFF. 

 

 

If you would like to view the point cloud in orthogonal projection, you need to click Ortho mode button. Enabling the 

function results in the button colouring blue. To rotate around all axes, disable the Orto mode by selecting the function 

one more time. 

 

 

If you would like to capture short movies from your 3D model with an external software, you can use Free flight function 

and smoothly fly around 3D model and objects. Use: left mouse click + keyboard. A to move left, D to move right, W to 

move forward, S to move backward, F to zoom in, R to zoom out, V to zoom in centre. Scroll to set vertical angle of view. 

To speed up the flaying press +, to reduce speed press -. 
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IF you wish to see PC and DSM at the same time, click Point cloud & DSM button. You can use this function in CAD tab, 

Point Cloud tab or DSM tab. This is a useful tool when you are working with Point Picking function. 

 

 

If you wish to see positions of cameras above the point cloud – reconstructed terrain, click Cameras. You can use this 

function in CAD, Point Cloud or DSM tab.  

 

 

Bounding Box – It is a useful tool for two reasons. 

First, move sections freely left, right, up or down and the tool lets you easily inspect the data inside the box whilst ignoring 

everything outside your box selection. 

Second, sliding 2 opposite Bounding Box panes together gives you a 3D profile of the surface model.  

Third, click and drag on any of the rims of Bounding Box and rotate bounding box around point cloud centre. To move 

through the 3D model press CTRL and left-click on the Bounding Box pane and you will be able to slide it in any direction 

and explore all the sections on the fly. Turning on the Height map displays the height differences even more clearly. 

Use Bounding box in either point cloud tab or DSM tab.  

It is possible to inspect the differences between several point clouds or surfaces, of course. For example, loading two-point 

clouds from the same area but measured at a different time and using Bounding Box will clearly show the difference. Apply 

different colours to surfaces for even more impressive results. 
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IF you wish to record desired parts of computed project and highlight significant details, click Recorder button. You can 

use this function in CAD tab, Point Cloud tab or DSM tab. This is a useful tool when you need to make quick presentation 

of project and made calculations. 

 

 

6.4. Point selection (PH, S) 

Click Select button and draw polygon around surveyed area using left mouse click. Finish the selection with right mouse 

click. Selected points will be coloured. 

Use the Deselection function to ignore interested points from selection. Left mouse click to select, with right mouse click 

to finish selection. Use ESC on keyboard to cancel selection or click clear button. 

 

If you click on the triangle, it will also be possible to make the selection based on CAD data or by selecting a colour from 

the cloud. 

 

Selecting a colour will open an interactive window giving a preview of the selected colour and you can change the tolerance 

parameter to select more or fewer points of similar colour. Clicking OK will select the corresponding points and you can 

decide what to do with this selection. 
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6.5. Deleting points (PH, S) 

To delete points, you need to select them first.  

 

Delete selected points either by clicking Delete selected button or use delete button on keyboard. Use Delete other 

function to delete everything that is not selected. Use Undo or Redo function in case you change your mind. 

 

6.6. Manipulate points (PH, S) 

Popup Manipulate points enables you to set height, increase height or compute average height of selected area. Select 

desired area and click set height. Type desired new height and click OK. The selected points are moved accordingly. 
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In case you would like to lower or raise the selected points use increase height function and type the desired value. For 

example, if you would like to lower the selected points for 0.5 meters type -0.5 m. If you would like to raise the selected 

point to specific value, type for example 1.5m and click OK. 

 

You can also compute the average height of selected points. Firstly, select the area of interest, go to Manipulate points 

and click Average height. 
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6.7. Calculating profile (PH, S) 

It is often required, especially on construction sites, to present profiles. Open Point cloud tab and click Calculate profile. 

Set the parameters in the pop-up: 

Consider point within distance 0.15 by default – distance of buffer zone for snapping longitudinal profile to PC, 

Approximate segment length 0.15 by default – approximate stationary distance of longitudinal profile, 

Calculate transverse profiles disabled by default – to set computation of transverse profiles, 

Distance between transverse profiles 10 by default – stationary distance on longitudinal profile to compute transverse 

profiles, 

Length of transverse profile on each side 10 by default – width of either flank of transverse profile. 

 

6.7.1. Longitudinal profile  

To compute longitudinal profile, Calculate transverse profiles must be disabled. Click Select profile definition line to 

define profile. 
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Left clicking the mouse, draw polygon, that defines longitudinal profile, ending it with a right mouse click. 

 

 

Calculated profile is displayed on the Point cloud in both 2D and 3D or on the mesh (purple line). 

 

Calculated profile, presented on orthophoto (green line) 
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Computed longitudinal profile is displayed in the working panel.  

 

Save project to save results. 

 

6.7.2. Transverse profiles 

To compute transverse profile, calculate transverse profiles must be enabled. Click Select profile definition line to 

define profile. 

 

Left clicking the mouse, draw polygon, that defines longitudinal profile, ending it with a right mouse click. 
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After right click, transversal profiles are drawn on top of longitudinal profile. 

 

 

You can observe defined profile presented on orthophoto, and open Profile. 

 

 

Transverse profiles are displayed below longitudinal profile, as displayed on the list in the Working panel. If you wish to 

view desired profile, you can zoom to it or click it on the list. 
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Using point clouds of two temporal measurements of construction site, you can observe reshaping of terrain, as presented 

below. Transverse profile shows two profile points, which present two measurements. 
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6.7.3. Profile manipulation 

Profile manipulation buttons/tools are displayed on the bottom of the profile window. 

 

• Profile points show point cloud points detected in buffer zone. 

 

• Profile lines show lines that define profile. 

 

• Anchor points show the interpolated point that defines the profile line. By double-clicking on the anchor point 

line, anchor points can be added and moved to better define the profile. 
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• Add Points and Added Points allows you to mark points and edit their names. 

•  

• Reset view returns the view to all profiles. 

• Reconnect, reconnects profile line between two selected anchor points. When you have a bump or undeleted 

object on top of the terrain, or if you would like to reshape it. Here we have transversal profile computed across 

construction machinery. 

 

To shape it to preferable curve or level, zoom to transversal profile and click two external points that present the desired 

shape. Click Reconnect button and the transversal profile will be reshaped. As you see, points that define transverse profile 

remain present as profile points - the new shape is displayed below them. 
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• Delete deletes selected anchor point and automatically reconnects neighbouring points. 

• Export, exports profiles between several possible formats: .dxf, .pdf, CADdy profile format (.Ing, .que). 

 

• Vertical exaggeration slide bar allows you to extend vertical scale of profile. 

 

 

• Text size: 

o Profile title, allows you to change scale of profile title. 

o Y – Axis, allows you to change scale on longitudinal axis. 

o X – Axis, allows you to change scale on vertical axis. 

o Point text, allows you to modify text size of added points. 
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6.8. Point cloud merge (PH, S) 

If you have different point clouds you can merge them to a new point cloud. Both point clouds need to be selected. Click 

Merge button to merge them into one. 

 

New point cloud appears called as the composition of the two previous clouds. 

 

 

6.9. Colormap (PH, S) 

When processing point clouds or DSMs, the data can be displayed in hypsometric scale. When displaying the desired data, 

click on the Colormap button to select the type of display you want. If the cloud is photogrammetric, only the Height Map 

will be present, while if you are using laser scanner scans you will be able to choose between Elevation, Intensity,Scan 

Time or Return data (this field may be missing, depending on the data your scanner saves). Once you have chosen the 

field, you will be able to view the coloured model according to the chosen feature with the accompanying scale and colour 

legend. Double-click on the colour legend to change it. 
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Is possible to set custom range for each colormap. To change the range, right-click on the colour legend and choose set 

range. 

 

 

 

Now the widow for range settings will pop-up. Here you can modify the range. 

 

 

 

Once you set the new range the visualization of the point cloud will change.  The part of the point cloud out of the range 

will be visualized with the original texture. 
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To reset the scale, right-click on the scale and choose reset range. 

 

6.10. Shading (PH, S) 

For better perception of spatial characteristics, point clouds, and meshes can be shaded Click on Shading button to display 

shades on point cloud points. This option is available if the point cloud has normal calculated. If not calculated, right-click 

on the point cloud name and click calculate normals. 

 

 

6.11. Delete (PH, S) 

Tick point cloud data that you would like to delete from application and click delete button. 

 

6.12. Generate CAD points (PH, S) 

Use CAD point generator and automatically extract points in regular grid of desired size, with CAD capabilities. You have 2 

options, select desired area or use CAD function and draw closed polygon for selection. Here, we guide you through first 

option. 

Select desired area of point cloud, and click Generate CAD points function. 
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Set parameters: 

• Point cloud: Choose from the drop-down menu the cloud from which to obtain points. 

• Point classes: If you have made the classification, decide whether to delete certain classes from the generation 

phase. 

• CAD layer: Choose the CAD layer in which to create the points. 

• Grid point spacing: default 5m. 

• Interpolation radius: default 0.15m. 

• Snap on lowest: Possibility to extract only the lowest points. 

Confirm by selecting desired option of selection. In our case From current selection. Generated CAD points with displayed 

height are presented. 
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6.13. Reducing point clouds (PH, S) 

Want to reduce point cloud points, but don’t want to process reconstruction again. Use Reduce point clouds function. 

 

Define desired point cloud and set desired number of point cloud points. Typed value, that must be lower than original 

point cloud. New point cloud appears with “-reduced” in the name. 

 

6.14. Saving point clouds (PH, S) 

Save project. You can export PC to – Select from dropdown list Point cloud -> Save as: 

*.ply – default Stanford mesh file 

*.las *.laz – laser and LiDAR files 

*.zlas – LiDAR ESRI file 

*.koo – file of coordinates, 

*.txt – text file. 

*.xyz – text file 

*.csv *.dsv – delimiter-separated values format 

*.pts – PTS format 

*.cl3 – TOPCON LC3 format 

*.e57 – ASTM E57 format 
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6.15. Calculate point cloud colour from photogrammetry images (PH) 

It is possible to recalculate a texture for a point cloud coming from laser scanner or from photogrammetry 

using images. The important thing is that the images and the point cloud are in the same reference system. 

First load the point cloud you want to retexture in the software. Second load images inside cube 3D. 

Process the bundle adjustment and create at least a sparse point cloud from those images. 

If needed perform the orientation for the sparse point cloud, so that everything is in the same reference 

system. 

Right-click on the pointcloud name and select colorize. 

 

The software will start to apply the colour to the point cloud, based on the images. 
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6.16. Classification (PH, S) 

Click Classification button to classify terrain points. In the pop-up window, you can adjust:  

• terrain elevation –maximal sudden elevation changes in terrain 

• terrain slope –maximal angle between horizon and slope in degrees,  

• minimal height – minimal height of objects to be deleted,  

• DSM cell size - cell size of previously computed DSM, 

• smoothing factor – proportionate to smoothness of classified terrain. 

• smoothing maximum size – maximal size of influential area. 

• pointcloud from laser scanning (LiDAR) - applies a different algorithm depending on whether the data comes 

from LiDAR or photogrammetry. 

 

 

After setting the parameters click on Continue. You will arrive at a new screen. Here select certain portions of what is visually 

recognisable as terrain. These will first be enlarged, based on the previously selected parameters, and finally displayed with 

a violet colouring. 
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Click on Continue to allow the software to refine the search for points to be classified. At this point you will move on to the 

second classification step with which to further refine the classification, if you notice any parts of the terrain that are poorly 

classified.  

If you are satisfied with the result click Finish, otherwise click Recalculate to repeat the procedure. 

 

Classification Parameters Guide 

The Classification Tool in Cube-3d operates in two primary steps: 1. Marking the Points, and 2. Filtering the Points. This 

guide explains the parameters involved in each step and their impact on the classification process. 

1. List of Parameters 

Terrain Elevation: Sets the allowable vertical difference when comparing the elevation of neighboring cells. A higher 

value allows more variation in elevation, enabling more points to be classified as part of the ground surface. 

Terrain Slope: Defines the maximum slope angle difference between cells. A larger slope value allows steeper 

variations, allowing more points to be considered as ground surface. 

Regular Grid Mesh Cell Size: Determines the size of each cell in the grid mesh. Smaller sizes capture more detail 

but may require more processing time, while larger sizes process faster with less detail. 

Smoothing Factor: Controls the amount of smoothing applied to the terrain data. Higher values create a smoother 

surface by reducing small variations. 

Smoothing Max Distance: Limits the distance over which smoothing is applied. This ensures that smoothing affects 

only nearby points, preserving larger terrain features. 

 

2. Classification Process 

The process of point classification is as follows: 
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1. Parameter Selection: First, select your classification parameters, including Regular Grid Mesh Cell Size, 

Smoothing Factor, and Smoothing Max Distance. Once the parameters are set, initialise the process by clicking 

Next. Upon initiation, a regular grid mesh is automatically created based on the selected parameters. This mesh 

organises the point cloud data for efficient processing. 

2. Terrain Region Selection: In Classification Step 1, you will be prompted to select some of the largest terrain 

regions across different areas of the point cloud. This manual selection helps the software identify and classify 

the main ground surfaces. The selected points are highlighted in RED to indicate they are classified as ground 

surface points. 

3. Point Filtering: The software filters points by comparing the manually selected cells with their neighbouring 

cells using the Terrain Elevation and Terrain Slope parameters. If the elevation difference or slope angle exceeds 

the specified thresholds for neighbouring cells, those cells are excluded from the ground surface classification. 

Consequently, higher values for Terrain Elevation and Terrain Slope result in more points being included in the 

ground surface classification. 

 

3. Example 

In the example below, there are two figures illustrating the effects of different classification settings. 

Default Classification Settings 

Figure 3a shows points marked and filtered using the default classification settings: 

• Terrain Elevation = 0.05 m 

• Terrain Slope = 18◦ 

• Regular Grid Mesh Cell Size = 0.5 m 

• Smoothing Factor = 1 

• Smoothing Max Distance = 0.05 m 

 

 

Figure 1: Points marked and filtered by default classification settings 

 

Increased Terrain Elevation and Slope 
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Figure 3b displays the results obtained by increasing the values of Terrain Elevation and Terrain Slope. Evidently, 

there is an increase in the size of the area marked in RED. The parameters used for this classification are: 

• Terrain Elevation = 0.1 m 

• Terrain Slope = 26◦ 

• Regular Grid Mesh Cell Size = 0.5 m 

• Smoothing Factor = 1 

• Smoothing Max Distance = 0.05 m 

 

 

Figure 2: Points marked and filtered by increased values of Terrain Elevation and Terrain Slope 

 

Effect of Smoothing Max Distance 

A similar increase in the marked area can be achieved by adjusting the Smoothing Max Distance parameter, which 

affects the classification as follows: 

• If the difference between the approximation of the regular grid mesh and a point is smaller than the 

Smoothing Max Distance, the point is marked RED (as part of the ground surface) in the second step of 

classification. 

• If the difference is bigger than the Smoothing Max Distance, the point is not marked. 

For example, increasing the Smoothing Max Distance to 0.7 m will result in less points being filtered out during the 

second classification step. However, this adjustment may lead to undesirable results, such as: 

• Kept points Around Vehicles: Points representing details like tires around cars may remain in the point cloud 

after classification. 

• Lower Parts of Building Walls: Points in the lower sections of building walls might also remain, resulting in 

less accurate classification. 

Careful tuning of the Smoothing Max Distance is essential to balance between reducing noise and preserving 

important terrain features. 

 

Special Case: Stockpiles 
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When performing classification on stockpiles, there is a high chance that the tops of the stockpiles won’t be included 

in the terrain surface. In Figure 3, we used the default classification settings, and as a result, the tops of the stockpiles 

were not included in the ground level. This can lead to inaccurate results when calculating volumes. 

 

(a) Ground surface - Default Classification Settings 

 

(b) Unassigned class - Default Classification Settings 

Figure 3: Comparison of Classification Settings 

 

To resolve this issue, we adjust the classification parameters by reducing the value of the Regular Grid Mesh Cell 

Size and increasing the value of the Smoothing Max Distance. After selecting the largest terrain regions, you will 

see that the tops of the stockpiles are now classified as ground surface (see Figure 4). 

While these adjustments improve the inclusion of stockpile tops, they may also result in unwanted features being 

classified as ground surface. Non-terrain elements like vehicle tires and the lower sections of building walls might be 

incorrectly included. 

The parameters used to include the tops of stockpiles in this case are: 
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• Terrain Elevation = 0.05 m 

• Terrain Slope = 18◦ 

• Regular Grid Mesh Cell Size = 0.25 m 

• Smoothing Factor = 1 

• Smoothing Max Distance = 0.08 m 

 

(a) Ground surface - Improved Classification Settings 

 

(b) Unassigned class - Improved Classification Settings 

Figure 4: Comparison of Classification Settings 

  

6.17. 2Dviews (S) 

This tool is used to extract layout and sections from the point cloud. 

Is suggested to calculate first the normal of your point cloud. Right-click on the point cloud name and select Calculate 

normals. For small projects as simplified size set 0, while for bigger projects you can increase this number. 

 



 

Stonex Cube-3d – User Manual   69 

  

 

After normal calculations, click 2D views. Select the point cloud you want to use. As target resolution for one single building 

set 1 cm, while for multiple buildings 2 cm. Color transparency can be set between 70% and 90%.  

Click generate to process the three prospective views. 

 

 

In the 2Dviews page will be visualized three prospective views Top, Front and Right. The available tools are: 

•   Align model. 

•  Calculate layout/section. 

•  Draw Points. 

•  Draw Lines. 

•  Point snapper setting, in order: on point, endpoint, middle point, nearest point. 

•  Block the line drawing along the X and Y axis of the object. 
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First, check the alignment of the pointcloud respect the axis. If is necessary to align the model to specific axis select the 

Align model tool. Choose a corner of the pointcloud, and draw the new reference axis. The three views will be recalculated, 

with the new alignment. 

 

Click on the Calculate new layout/section button to draw a new cut or section. Start from the Front or Right view to create 

a layout, while start from the Top view to create a vertical section. 

Use the mouse to draw the red central line of the cut.  Define the thickness of the section that will be used to calculate the 

layout by choosing the perimeter of the yellow area. Is also possible to define the resolution parameters of the new layout 

by clicking show more. Finally, click on Confirm to calculate the layout. 
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Right-click on the name of a view/layout/section to recalculate or export it: 

 

2DViews – Export formats: 

 

 

With the draw CAD points button, you can draw CAD points directly from a section or plan. After clicking, move the cursor 

over the plan and select a point. This will be saved in the active layer in the CAD section of Cube-3D. 

With the draw CAD lines button, you can draw CAD lines directly on a section or a layout. Zoom the layout and start drawing 

by selecting positions of points that will create the vectors. When you want to end the drawing, right-click. This will be 

saved in the active layer in the CAD section of Cube-3D. The colour visualized will be the same one as the CAD layer. 
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Is also possible to extract automatically vectors from layout. 

Right-click on the layout name and select Detect lines. A parameter window will open. Choose the CAD layer where the 

vectors will be created. The threshold parameter is related to the number of the lines extracted. It is set autoamtically by 

the software to extract the 70% of the white pixels. If you need more lines reduce the threshold value. 

 

  

The software will create the lines. Is possibleto complete the lines drawing in the 2dviews or in the CAD section. 

 

 

6.18.  Point cloud with panoramic images (S) 

In Cube-3D is possible to load point clouds with panoramic images information already saved in them. The 

supported format is the *.e57. 
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When you load a point cloud you can choose f load the images or not. 

 

Once loaded you will see some bubbles in the correspondence of the images, and on the list, you can 

manage the visible bubble. 

You can turn on off the bubbles and specific bubble. 

 

To enter an image double click on one of the bubbles. The image will open. To move in the image, hold the 

left mouse click and pan with the mouse. With the mouse gear you can zoom in an out of the image. 
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To switch to a different image, double click on another bubble.  

On the images is possible to use the CAD tools. Enter the bubble, select the CAD tool of interest and start to 

draw on it. 

 

Shortcuts available when using panoramic images: 

Shift + gear rotation: apply a transparency to the image to see the point cloud under it. 

Ctrl+W: exit the current panoramic image. 
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7. Mesh manipulation (PH, S) 

Point clouds can be presented as 2 types of meshes: 

• DSM, made from points in regular grid, that don’t present overhanging surfaces. 

• full 3D mesh, made from points in irregular grid, that present overhanging surfaces. 

 

7.1. Calculate digital surface model (PH, S) 

Select from dropdown list Mesh -> Calculate new DSM and set parameters. 

 

The default parameters are: 

• From point cloud: select the point cloud from which to derive the DSM. 

• Grid cell size: the default is the optimum value for the software. 

• Hole-filling mode: choose between All, Optimise or None. 

• Smoothing size: the number of cells on which the software will perform the chamfer calculation. 
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The higher the smoothing parameter, the smoother the surface will be. Comparison of three DSMs shows that higher 

smoothing size gives smoothest surface. Selected models present the effect of three smoothing sizes:  

• 10 cells (red) – the smoothest 

• 5 cells (purple) – semi-smooth  

• 1 cells (blue) – the least smooth. 

 

To export computed Meshes, you need to do it on at a time. First view just the one, you wish to save. Select from dropdown 

list Mesh -> Save as: 

• *.ply – default Stanford mesh file 

• *.dxf – DXF drawing exchange format 

• *.txt – text file 

• *.koo – file of coordinates, 

• *.xyz – text file, 

• *.stl – stereolithography format, 

• *.obj – Wawefront OBJ format, 

• *.dae – Khronos COLLADA format, 

• *.xml – landXML construction format, 

• *.tiff *.tif – TIFF image format with georeferencing (only for DSMs) 
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7.2. Calculate texturized full 3D mesh (PH, S) 

* texture is only applicable for models obtained from photogrammetry. It is however possible to calculate a full 3D mesh from 

a LiDAR point cloud. 

Select from dropdown list Mesh-> Calculate new Mesh and set parameters. 

 

Most commonly used, default parameters are: 

• Calculation level: Medium 

• Maximal number of triangles: 2.000.000 

• The highest number of triangles can be set to 10.000.000 and allows you to make most completed 3D mesh. 

Comparison of four Meshes shows that higher Calculation level gives completed – most detailed surface at the same 

maximal number of triangles. Selected models present the effect of four calculation levels:  

• low (purple) – the smoothest surface without edges 

• medium (blue) – smoothest approximation of edges 

• high (turquoise) – half smoothed edges 

• extreme (green) – sharp edges with barely smoothed surfaces 
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7.3. Draping digital orthophoto (PH) 

For better visualization and spatial presentation, multiple Orthophotos can be plastered on top of multiple DSMs. Go to 

Mesh tab and select function Drape Orthophoto. 

 

Set preferred combination of orthophoto and DSM. Remember, only DSM can be used for draping. Below is a comparison 

between non-textured and textured mesh. 

 

As orthophoto is plastered on top of regular grid mesh, function Show texture becomes activated. 
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7.4. Show texture (PH) 

Viewing of plastering of true or traditional orthophoto on top of full 3D or regular grid mesh can be memory consuming.  

Use Show texture function to manage texture-viewing ability. 

By right-clicking on a mesh, it is possible to activate or deactivate a reduction in texture quality by selecting "Texture 

compression". It always reduces the use of computer memory. 

 

 

7.5. Show grid (PH, S) 

If you want to see wire surface of undraped DSM, click Show grid button 
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7.6. Wire only (PH, S) 

If you want to see wire of undraped DSM, click Wire only button. 

 

 

7.7. Flatten (PH, S) 

Check for any objects that you would like to filter out of the model. 

First select recognised masses extended to surrounding area with preferable height. To eliminate masses, use function 

Flatten. 
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After Flatten: 

 

 

7.8. Volume calculation (PH, S) 

Volume calculation based on interpolated surface: Calculate volume of material for single measurement - appropriate for 

the calculation of dredged material. 

How? 

Calculate or load point cloud of selected area -> Click Mesh -> Calculate New DMS and set calculation parameters as 

shown in Option settings .Now you have two options for selecting area of interest:  

1. Manual selection using the selection function.  

- Click on the Select button and select the area for volume calculation with a left mouse click. To end the 

selection, click the right mouse button.   

- To calculate the volume on the selected area, click on Calculate Volume. 

- For the initial surface, use the default value Interpolate surface. 

- For the final surface, select: Calculated DSM. 

- Click on from current selection to calculate the volume of the selected area. 

2. From a .dxf file using the CAD functionality for repeated or detailed use: 

- To calculate the volume of the area, defined by the dxf boundary, click Calculate Volume.  

- For the initial surface, use the default value Interpolate surface. 

- For the final surface, select Calculated DSM. 

- Click From DXF and open the desired file. 
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When Calculate volume is in process, the initial surface will be generated first, based on points closer to the edges of 

selections! Volume is calculated as subtraction of two surfaces. 

 

 

Displayed results present values for both current volume selection and a total sum of all volumes, consisting of: 

• Fill – volume of needed mass to fill holes beneath mean surface. 

• Cut – volume of mass above mean surface 

• Total – sum of filled and cut volume 

• Are 3D – three-dimensional area of selected surface 

• Area 2D – horizontal area of selected surface  
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Select Volume from the Working panel to observe all calculated volumes. Areas of volume calculation are presented as 

cuts from draped DSM, each with its own title. If Contour lines are visible, their cuts are also presented. You can select, 

deselect and remove selected volumes. 

 

Volume calculation based on two consecutive measurements: Ideal for monitoring on construction site. Measure the 

volume difference between two consecutive measurements. 

How? 

Calculate or load two point clouds the area you would like to calculate -> Click DSM -> Calculate New and set DSM 

calculation parameters as shown on the image below. 

Now you have two options for selecting area of interest:  

• Manual selection of the calculation area using the selection function. Click on the Select button and select the 

area for volume calculation with a left mouse click. To end the selection, click with the right mouse button.  To 

calculate the volume on the selected area, click on Calculate Volume. For the initial area, select the initial area for 

the final area, select the final area Click on from current selection to calculate the volume of the selected area. 
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• Use a CAD .dxf file as a contour. To calculate the volume of the area defined by the .dxf boundary, click Calculate 

Volume.  For the initial surface, select the initial surface. For the final surface, select the final surface. Click From 

CAD and open the desired file. 

 

Displayed results present values for both current volume selection and a total sum of all volumes, consisting of: 

• Fill – volume of needed mass to fill holes beneath mean surface. 

• Cut – volume of mass above mean surface. 

• Total – sum of filled and cut volume. 

• Area 3D – three-dimensional area of selected surface. 

• Area 2D – horizontal area of selected surface. 

 

To remove a volume, go to the Volumes page, select the volume to be deleted and press delete. 
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7.9. Calculate contour lines (PH, S) 

Click button Calculate Contour lines. Select desired equidistance in the pop-up window. Check simplify if more smoothed 

lines are needed. 

 

Calculated contour lines are displayed on the DSM. To export, go to Contour lines tab in Working panel. 

 

Contour lines’ height can be displayed by checking Show height box. If you right click on the contour line name, is possible 

to simplify again the result. To export contour lines, choose between *.DXF and *.PDF data types. A new window, titled 

Save contour lines as DXF or Save contour lines as PDF, pops up. Enter desired file name and click save. New window 

with exported file path pops up. 
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7.10. CAD projections on mesh (PH, S) 

If the CAD layers imported in the software does not have the correct height information, is possible to 

project them on a mesh. Right-click on the mesh name and select Project CAD on mesh. 

 

You can choose the layers to be projected, and how to snap the vertex on the mesh if on lowest or highest 

point. After the projection the points will be overlapped with the mesh. 
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7.11. Delete (PH, S) 

Tick Mesh data, you would like to delete from application and click delete button. 
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8. Digital orthophoto (PH, S)  

Cube-3d offers computation of two types of orthophoto: 

• original orthophoto based on regularly gridded mesh 

• true orthophoto based on irregularly gridded full 3D mesh 

 

8.1. Digital orthophoto calculation top-down (PH) 

Select from dropdown list Orthophoto -> Calculate new. 

 

Set parameters in a Digital Orthophoto Calculation pop-up. First, set Desired resolution. As entered value may not be 

possible to compute, Actual resolution is presented below to inform you about the closest available result. It is an outcome 

of entered desired resolution and DSM cell size based on selected DSM. Click more to check the split DOF box. Default Tile 

maximum size is set to 20.000, meaning DOF will be split if it exceeds 20.000 pixels. When set, click Calculate. 

In the panel called orthophoto, will be visualized all the calculated orthophotos. 
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To save the orthophoto, click on Export and choose between PDF or image. The following formats are available as images: 

*.jpg *.jpeg + *.jgw 

*.tif *.tiff + *.tfw 

*.png + *.pgw 

Whether you export as an image or, as a PDF, you can decide the area to be saved, whether to include measurements, such 

as volumes or profiles, as well as having specific parameters depending on the output format. 
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8.2. Digital orthophoto corrections (PH) 

To calculate digital Orthophoto follow steps from 1 to 11 (page 2- 21). If you are not satisfied with results, you can use 

correction tools to improve them. Because of low flight altitude, often artefacts on roofs of the houses will appear.  You 

can easily correct them with Recalculation orthophoto tool. 

Note: Simply loading your Orthophoto into Cube-3d is not enough for Recalculate orthophoto function. To be able to 

recalculate, one needs to go through the whole process for orthophoto calculation.  

How? 

When your Orthophoto is calculated, select the areas you would like to recalculate. Use Select button and select preferred 

images. 

 

Wizard for image selection, with images of selected area will appear – select the image you would like to use for 

recalculation and click Confirm. 
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In case of additional artefacts repeat the same process to select all the areas. When you are finished with selecting click 

Recalculate orthophoto button.  

 

 

Results: 

  

Before After 
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8.3. Cut orthophoto (PH, S) 

You can also cut certain area out of the DOF and save it as another DOF. Click Cut. 

 

Select desired area. Left mouse click to start drawing rectangle and drag mouse to select rectangle over desired area. You 

can observe coordinate values in left bottom corner and coordinate range of selected rectangle.  

 

When area of interest is selected, click confirm to calculate the orthophoto cut. 

 

8.4. Merge orthophoto (PH, S) 

Merge is a function that merges two orthophotos that don’t need to overlap or even converge. 

Load or select desired orthophotos and click Merge. 
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In a pop-up window, select the area you want to merge. Left click on one end and set the rectangle across interested area. 

Click Next. 

 

If you click on an orthophoto on the right side, it will be displayed. You can select a specific area of the orthophoto with 

the select area to merge command. Click on the Paste orthophoto button to paste the selected part onto the new 

orthophoto. Click on the next orthophoto in the list to set its transparency by adjusting Alpha. Select the desired area on 

the second image - the Alpha adjustment shows the merging boundaries. The Blending Size allows you to smooth the 

edges between the overlapping parts. When all parts are merged, click on Finish. 

When the merging finishes, the new orthophoto (merged) is displayed. 
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8.5. Calculate area (PH, S) 

Click Calculate area button to compute area on the orthophoto. Select area with polygon using left mouse click to 

determine points and right one to close it. Area result, will popup: 

• Area – planimetric area of selected region, 

• Perimeter – circumference of selected region or length of polygon 

 

 

8.6. Delete (PH, S) 

Tick DOF data, you would like to delete from application and click delete button. 

 

8.7. Ortophoto from a pointcloud (PH, S) 

To create an orthophoto from a point cloud, select the desired orthophoto type, between top-down and custom plane. 

Select the plane if necessary and set the desired resolution. Click on calculate and the system will calculate an orthophoto 

on the selected point cloud. 
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9. CAD Functionalities (PH, S) 

There comes a need, when you wish to draw on your point cloud. Draw objects entities that could further be used in 

Computer aided design (CAD) programs. In working panel tab CAD. At the top is a working panel tool bar, with edit tool, 

selecting tool, draw line tool and draw circle tool. You can check all layers in the layer list on working panel. Each layer 

has its attributes (whether it’s selected, visible or locked), name, colour and line weight. 

9.1. Preparing layers (PH, S) 

As all CAD applications tent to use layers, it is useful, if you first make new layers, assign their colour and line width. Click 

+ to make new layer. To change name, double click it. Pres enter to confirm. Double click on colour square, to change the 

colour. Change line weight by double clicking on number. Type new weight. Those layers that are visible, have a scheme 

 in the second row, as oppose to nonvisible ones . At the time, only one layer can be selected, in the second row

is visible, as oppose to all the others . Third row shows whether layer is locked  or unlocked . To change 

any of layers attributes, click on unwanted scheme in desired row of layer. 

 

 

9.2. Select tool (PH, S) 

Use select tool   to select multiple drawn CAD objects. By selecting from left to right, you can select different points. 

• when you draw selection from right to left, all objects, of which parts were inside selection are selected. 

• when you draw selection from left to right, you will select only those objects, of which all parts are being selected. 

 

9.3. Draw point (PH, S) 

To draw set the desired layer and select draw point tool . Go to snapper settings and tool settings to select type of 

snapping and display settings. If you want to snap directly on point cloud point, select point snapper. This option 

supports also snapping on endpoints, midpoints and on or near existing lines. Each point can have displayed name, height 

and code. Size of displayed text and code value can be specified. 
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9.4. Draw line (PH, S) 

To draw set the desired layer and select draw line tool . Second, click on snapper settings to select type of snapping 

and measurements display. If you want to snap directly on point cloud point, select point snapper. This option supports 

also snapping on endpoints, midpoints and on or near existing lines.  

2nd option is to draw the line by creating new points – this option is useful in case you don’t have a certain point cloud 

point to draw on – in this case interpolate points and select desired radius of point snapper to define the average height 

(at least one point of the point cloud needs to be in the blue circle) of the new point which will be created in the centre of 

the mouse cross. You can select different parameters to be shown in the drawing in the Show section. 

 

Start drawing lines, using left mouse click. If you mis-clicked use backspace, to delete last point. Abort drawing at any point 

with escape button. End drawing polygon of lines using right mouse click. 
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If you want to end drawing polygon on already drawn point, select to use element snapper an approach desired point 

with your cursor. As snapper is active, already drawn element/elements will mark. Click at desired point with left mouse 

click and continue to draw. You can change snapper settings while drawing CAD objects. 

 

 

9.5. Draw circle (PH, S) 

To draw a circle, select draw circle tool and desired layer. Select type of snapping, and snapping zone. Left click circles 

base point, drag mouse to assign diameter, confirm with left mouse click. Use right mouse click as well as escape button to 

abort drawing. 
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9.6. Measure tool (PH, S) 

To measure set the desired layer and select measure tool . Second, click on snapper settings to select type of 

snapping. If you want to snap directly on point cloud point, select point snapper. This option supports also snapping on 

endpoints, midpoints and on or near existing lines. Left mouse click on the first end of measurement and then on second. 

You can select the type of measurement to show between distance (2D or 3D), slope, elevation difference (ΔHeight) or 

azimuth. Click esc to exit or continue measuring.  

 

9.7. Edit tool (PH, S) 

To edit drowning, select edit tool  and get close to desired objects. When marked, select it with left mouse click. You 

can move, redraw or delete selected points or objects. Click on the drop down button of edit tool and click on: 

• select similar to select same CAD object drawn on all layers. 

• select similar on same layer to select all CAD objects on layer of selected object. 
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All data of selected object or layer are displayed in Element properties window of working panel. There you can change 

its colour, line type or layer by clicking on desired attribute and change it from available possibilities. 

 

9.8. Photo-assisted CAD drawing tool (PH) 

Draw with CAD tools directly on images, for more precise point selection, directly on the sparse point cloud (no need to 

reconstruct the dense point cloud!). It is also easier than drawing on a mesh.  

Select a CAD layer and start selecting a point; the photo drawing menu will appear on the left-hand side of the screen. 

 

You can use the slider to adjust the zoom of the images, and the grid icons to select how many photos to display: 
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Use the photos to position the cursor on the desired point, using the different angles to ensure that the selected position 

is the correct one. 

When selecting a point on the 3D scene, the images with the closest perspective to the viewing position are displayed 

first. 

9.9. Draw on planes (PH, S) 

To improve the CAD drawings is possible to set a custom plane to be able to lock all the drawings to be in the same 

plane. 

First click on Define Plane and select at least one point to define the plane. A yellow plane will be identified. The more 

complex is the plane the more pints will be needed to define it. To define a vertical plane, you need at least three points. 

Once the plane definition is done, click Confirm plane. The plane will become blue. 

 

 

From now on all the points or vectors you are drawing will be projected on the plane. 
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Once a plane is defined, is also possible to lock the direction of the vector. By clicking Object UCS the vector will be 

created only in the perpendicular directions of the last vector drawn. 

The tool is good to be used in combination with the Top down view and the Ortho mode render of the point cloud. In 

this visualization from top is possible to easily draw floor plans or perimeter of buildings. 

 

The plane definition of plane can also be used in combination with panoramic images. First create the plane, second 

enter in the panoramic image and start to draw. This will improve the accuracy of the drawing. 

There are two shortcuts in the keyboard that can be used when dealing with planes. 

Hold on Q: will create a local plane based on the height of the point you are selecting. If the Q is not hold the plane will 

be resetted. 

Press F8: will turn on and turn off the Object UCS tool. 
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9.10. Clipping with CAD (PH, S) 

It is possible to cut out point clouds, meshes and orthophotos using a polygon drawn in CAD as a base. You can either 

draw the line in Cube-3D or import one already drawn in other software. 

After drawing the line, select the element you wish to crop, right-click and select Clip. 

 

Select the layer where the clipping line is located and click compute. 

 

The software will automatically calculate a copy of the object, cropped to the edges of the CAD line. 
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10. Recorder function (PH, S) 

Sometimes you wish to make video presentation of point cloud and measurements made on it. Click Recordings button in 

the viewer. A Video recorder with instructions pops up.  

 

As described, you need to rotate/move/zoom to desired start point and click Add button to create first recording camera. 

Proceed throe entire area, creating new cameras to capture desired details. A recording trajectory appears between selected 

camera positions. Define desired time of recording duration.  

 

Click preview to preview flight and it’s duration. By clicking on a camera from list, you can remove or modify it. When you 

click modify, cameras position is moved to current viewpoint. Add new ones if pleased. Remember, you will display types 

of data and measurements once you record. Once you created desired path of needed duration, click Record. 

Video export setting window pops up, where you need to set the path and name of saved recording in mp4 format. Adjust 

Frame rate and bitrate if desired. Select weather you want watermark in the recording. Once set, click Confirm to start 

recording. 
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As recording is following desired path, change displayed data by switching between CAD, Point Cloud, DSM, Profile, 

Contour lines and Volumes from Working panel. Switch between Viewing options to achieve desired effect. Once you are 

viewing point cloud, you can also display it with dsm. When you are viewing dsm, you can display it with point cloud as 

well as drape orthophoto on it. When switching viewed data, observe recording bar, so, that all data is displayed in desired 

proportions of time! Once the recording has completed, close Video recording window. 
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11. Reports (PH, S) 

Generating a general project report and/or measurements report, is basically in a few clicks and the report is done. General 

report contains information about imported/processed images, geo-referencing, camera positions, flight characteristics, 

calculated accuracy, GCP positions, orthophotos, DSMs, error summary. With measurements report you get the ability to 

include all your calculated data, profile lines details, volume and stockpile measurements, and contour lines.  

 

11.1. General report (PH) 

To create a general report, click Project - > Generate report - > General report. 

 

Enter the document’s name and select the data you want included in the report. If not, Cube-3d automatically selects top 

listed data from all working panel tabs. 

 

After the report is generated, the folder with report file path pops up for you to verify the information. It is created in *.docx 

file which makes it easily customizable. Simply save it as pdf in your text editor if needed.  

Here is a quick overview of a general project report. 
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Stonex Cube-3d – User Manual   109 

11.2. Measurement report (PH, S) 

To create Measurements report, click Project - > Generate report - > Measurements report. 

 

Enter the document’s name and select the data you want to have included in the report. If not, Cube-3d automatically 

selects top listed data from all working panel tabs. 

 

After the report is generated, the folder with report file path pops up for you to verify the information. It is created in *.docx 

file which makes it easily customizable. Simply save it as pdf in your text editor if needed.  

Here below is a quick overview of a measurements report. 
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system requirements 
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